












































































































































































































































































































































































10 I 
) 

Figure 7.34 The left end of the 
paragraph ruler 
enlarged 

STEP13 

10. 

Figure 7.35 Setting paragraph 
indentation 

STEP14 

STEP15 
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The left arrow ru les the left margin of the paragraph, 
the right arrow rules the right margin , and the white dot, 
which will turn black when you move it onto a white 
background, rules the indenting of the first line. Figure 
7.34 shows them in enlarged form. 

Move the point of the cursor to the white dot , (it 's not as 
hard as it looks in the illustrations), press down the mouse 
button, and slide the cursor to the half-inch mark (see figure 
7 .35). As you move the cursor, the number in the First Line 
box in the Paragraph Formats dialog box also changes. 

Move the right margin arrow into the 4 1/2-inch mark. 

You can write in the boxes where numbers appear in the 
Paragraph dialog box. Replace 0 lines following each para­
graph with 1, and change the 0 in Left indent to 0.5 , and 
check OK. 

Uniuerse 
3 

The Universe 

Figure 7.36 Setting up paragraph indenting and line spacing 

The paragraph will appear as in figure 7. 3 7. 

Birth 
Text text text text text text text text text text text 

text text text text text text Text text text text text text 
text text text text text text text text text text text I 
Death 

Figure 7.37 The paragraph as formatted 
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Time! 
Text text tex 

text text text text 
text text text text b 

Figure 7.38 The page number box 
showing a second 
page count has risen 

to two 

STEP1 

STEP2 

Figure 7.39 Selecting Footnote on 
the Document menu 

Select the paragraph. Pull down the Edit menu and select 
Copy. Set the insertion point after the heading Death and 
press Return to create space for a copied paragraph. Pull 
down the Edit menu and select Paste. 

Repeat the process of copying the paragraph of text after 
the headings Laughter, Love, Moonlight, Stars, Planets, 
Earth, Space, and Time. This will lengthen the paper to two 
pages. Of course, in a real paper you would type out para­
graphs discussing these topics. Note that the page count in 
the lower left-hand corner of the window turns to two. 

It is fairly easy to make a mistake and mix paragraphs 
so that, for example, the indenting of one of the headings 
takes over the indenting of the text. You can easily separate 
them by setting the insertion point at the proper boundary 
and pressing Return. Once they are separate, set the inser­
tion point in the paragraph with the wrong margins, pull 
down the Paragraph menu and select Format. The dialog 
box will appear and you can set the margins and line space­
ing correctly. 

This would be a good time to save the file again. 

Inserting Footnotes 

This section will show you how to attach the footnote 
"You've always got to keep your sense of humor." to the 
end of the text under Laughter. The footnote will then 
appear at the bottom of the page. If the paragraph were 
moved to another page the footnote would go with it. You 
could also put the footnote at the end of the paper. Word 
will number the footnote automatically, but it is possible to 
number by hand with *, t, etc., or any other character. 

Set the insertion point after the last character in the text 
about Laughter. 

Pull down the Document menu and select Footnote. 
The Footnote dialog box will appear. 
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Figure 7.42 Closing the footnote 
pane 
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Click OK. 

~ Auto-numbered Reference H OK g 
or ( Cancel ) 

Footnote Reference Mark: [I 

Figure 7.40 The Footnote dialog box 

The numeral 1 will appear where the insertion point 
was blinking and the window will divide into an upper and 
lower pane. The footnote number will appear in the lower 
pane that contains the blinking insertion point and you can 
begin typing your footnote there. 

text text text text text text. Text text text text 1:.&0 
Feelings 
Love 

Text text text text text text text t&xt t&xt t&xt t&XI 
text text text text text text. Text t&xt text text text t&x 

•You've always got to keep your sense or humour. 
<> 

Figure 7.41 Typing in a footnote 

To hide the footnote window, move the cursor into the 
pane bar (figure 7 .42), hold down the mouse, and drag the 
top of the pane to the bottom of the screen. The footnote 
will appear when you print the paper even though it might 
not appear on the screen (see figure 7 .48). 

The pane bar will return to the top of the screen. You 
can open the footnote window at any time to edit any 
footnote by holding down the Shift key, retouching the 
pane bar with the point of the arrow cursor, holding down 
the mouse button and dragging the pane bar down the 
screen. Editing footnotes is exactly like editing any other 
kind of text in Word. 

To delete a footnote, remove the reference number in 
the text. If numbering is automatic, Word will renumber 
any remaining notes. 

Running Heads 

Running heads are text that appear on every page of a 
document at the top above the regular body of text. Word 
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STEP1 

STEP2 

STEP3 

STEP4 

enables you to put a running head on every page, or one 
that appears on the odd (normally right-hand) pages and a 
different one on left (normally even-number) pages. You 
can also have running footers at the bottom of the page, but 
not both running heads and footers. This example shows 
one running head on the even (left) page-the name of the 
paper-and another on the odd (right) side-the name of 
the writer and the class assignment. 

You can put the running head anywhere in the text, 
but it will only take effect on the page where it appears and 
those following. It seems most orderly for this short paper 
to put it at the very beginning. But the very beginning is the 
title, in 20-point, bold, centered letters which is a little 
heavy for a running head.,You will need to create a new 
paragraph (by inserting a return) and give that paragraph an 
appropriate format for a running header. 

Set the insertion point at the very beginning of the paper. 
Press Return. Pull down the Character menu and select 
Formats. Alter the Formats dialog box by clicking on Bold 
to deselect it which leaves the text Plain; select Underline, 
and 12-point text. 

Cherac:ter Formats n OK I 
Style----. .. 
0 Bold ( Cenc:el ] 
Oltellc: 
181 Underline Position 
0 Smell Caps ®Normal 
0 Outline 0 Superscript 
0 Shedow 0 Subscript 

Figure 7.43 Setting up the format for a running head 

Pull down the Paragraph menu and select Normal. 

Type "The Universe" and then select the text. 

Pull down the Document menu and choose Running 
Head. The Running Head dialog box will appear. 
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Running Heed U OK D 

.-Occurs on- [ Cencel ) ... 

181 Odd Peges J~Position~ 0 Euen Peges ®Top 
181 First Pege 0 Bottom 

Figure 7.44 The running head dialog box 

Check: Odd Pages, First Page, and OK. Often the first page 
is a title page, where you wouldn't want the running head 
to appear, but since this example paper is only two pages 
long, the odd running head must appear on the first page if 
it is to appear at all. 

The running head symbol, a low, small double bracket 
that looks like a quotation mark from French or Spanish, 
appears in the left margin to show that this paragraph will 
not print where you see it, but rather as a running head (see 
figure 7 .45). 

The Uniyerst 

The Universe 

Figure 7.45 Running heads for odd and even pages with the right page head 
selected 

Set the insertion point at the end of the running head, press 
Return twice and type the name of the writer, his class, and 
date (Paul McCarthy, Cosmology 101, Mr. Occam, 
November 1, 1985). Select the text you have just typed. Pull 
down the Document menu and select Running Head. 
The boxes are preset to show the same header on both odd 
and even pages. Check Odd to reverse the preset; this lets 
the heading appear on Even only. Check OK. The mark of 
the running head will appear beside this text. 

Note the raised small "c" in McCarthy. Those of Irish 
or Scottish descent can obtain this fine touch by selecting 
the character, then pulling down the Character menu and 
selecting Superscript. 
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Page Numbers in Running Heads 

Word will number your pages automatically in the 
upper right-hand corner if you do not have running heads. 
Running heads preempt the space where the page numbers 
normally go. The simplest way to provide page numbers 
when you have rtinning heads is as follows. 

Select the end of your running head. Type "Page". Hold 
down the Command key and press Backspace. Page will be 
replaced with (page). The (page) is a place holder. The real 
page number will appear when you print the page. Figure 
7.46 shows this step halfway through. In the upper running 
head, (page) is in place; the lower running head is waiting 
for the Backspace key to be pressed while the Command 
key is down. 

r 
The Uniyerse (Jmg2). 

~ocarthy.~'U.Q.l. Mr. Occam. Novembtr 1 19_8.5hgd 
The Universe 

Figure 7.46 Making page numbers part of the running head 

When you put page numbers in a running head you are 
making use of a feature that Word calls a glossary. With the 
glossary feature you can put some short string of characters 
in a file and have something else replace it when you print. 
For example, to save typing you could insert@ and have 
some lengthy phrase replace it when you print. Word 
offers two types of glossary, those you define yourself, and 
a set of standard glossary items, one of which is the page 
number. A file of standard glossary items comes with 
Word. If you are using only one disk drive, it is necessary to 
have the glossary file on the diskette you are using in order 
to make page numbers appear in running heads. If you are 
using a second disk drive, the glossary file can be on either 
diskette. 

To make it clear in the printed version that the page num­
bers are page numbers, set the insertion point between the 
text and (page) and type spaces to separate the number 
from the rest of the heading. 
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re Uniyerse (~gtl 

~~~~L.l.QJ.. Mr Occam, November I 19.A5___(R§gt>. 
The Universe 

Figure 7.47 Running heads with spacing to set off page numbers from text 

STEP3 To print, pull down the File menu and select Print. The 
standard Mac printing dialog box will appear. Printed with 
the standard rather than the high-quality print style, the 
paper looks like figure 7. 48. 

The Unjverse 

Events 
Birth 

The Universe 

Te1t te1t tell te1t te1t tell te1t te1t telt tell te1t 
telt telt tell ten tell tell. Te1t telt tell tell tell ten 
telt teJt telt telt ten ten ten tell telt teJt ten~ 

De alb 
Te1t ten telt te1t ten ten telt ten telt teJt tell 

telt tett ten text ten telt. Text text ten ten tell ten 
ten telt text text te1t te1t teJt teJt ten te1t text. 

Lauabter 
Te1t text te1t text ten text tell text te1t text text 

teJt ten teJt tell telt ten. Tett text tell telt teJt teit 
tett ten text telt tell text text text text tett tell. • 

Feelings 
Love 

Text text tell tell tell tell tell tell tell tell te1t 
ten ten telt telt tell ten. Ten ten ten text tett telt 
ten teJt teJt text tell telt telt ten ten text text. 

Energy 
Moonlight 

Text text lett telt text text text text ten ten text text 
telt telt ten text text. Text tell text text telt tell tell te1t 
ten tell ten telt ten ten tell ten text. 

Malter 
StU I 

Ten ten ten tell tell ten ten tell text text telt 
ten text tell tett tell ten. Ten tell tell tell tell tell 
telt text ten telt telt telt telt teJt telt te1t text. 

El!JWL 
Te1t tell tell ten tell tett ten text text tell tell 

ten text tell text text tell. Text tett text tett tell text 
ten tell text ten tell tell tell ten text ten text. _ 

lfou·ve always got to keep your sense of humor. 

fl.ltl..MtCarthy Cosmology I 0 I Mr Occam November 1 198$ 2 
.E6rlb 

Ten text tell tell text tell ten tell text telttext 
text text text text text text. Text text tell text text text 
text ten telt tell tell text ten text tell te1t ten. 

OriD6e.f 
0t:e1o 
Men 
.Vi~ 
W'omtM 
Apples 
Space 

Text ten text text ten text tell telt te1t tell text 
ten ten text text telt text. Tell tell ten text text text 
tell text text text text text telt text text tett tett. 

Time 
Text tell text te1t text text te1t text te1t telt text 

te1t tell text text tell ten. Text text text telt te1t ten 
ten tell telt ten text text telt tell text text tell. 

Figure 7.48 Printed with standard rather than high quality print style 
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Making a 
Brochure for 
Thorn &Co. 

STEP1 

Figure 7.49 The catalog on a 
word diskette 

STEP2 

STEP3 

In this section we will create a brief brochure for Thorn & 
Co. The format is an 8112-by-11 inch sheet printed sideways 
in three columns and folded. This section demonstrates 
more than any other the possibilities and the number of 
steps and planning required to use material from several 
programs. It shows copying an illustration from a commer­
cial clipsheet diskette (CiickArt); copying a table from Mul­
tiplan; copying a chart from Chart; and editing in MacPaint. 

If you don't have ClickArt, you can use MacDraw to 
make an example. If you don't have Multiplan, you can 
type in a table in 12-point type in Mac Write. 

Setting up the Format 

Put the Word diskette in the Mac and turn it on. If the 
catalog does not appear, click twice on the diskette icon to 
evoke it. 

Word sometimes generates files for its own purposes 
during a task. They appear in the disk catalog with myste­
rious names like MWOOl and Font Widths. Don't worry 
about them, because there is nothing you can do with them; 
everything that needs to be done the program will do. 

Click twice on the Word icon to create a new Word file. 

After some whirring the machine will eject the diskette and 
show a message to put in the Word Master diskette (figure 
7. 50). Microsoft's copy prevention system requires this 
step. Remove the copy diskette and insert the master. After 
a little more whirring the system will eject the master 

Please Insert the Word 
Master disk I Cancel I 

Figure 7.50 Prompt box that requests insertion of the Word Master diskette 



STEP4 

STEPS 

Advanced Word Processing 179 

diskette and ask by name for the copy. Remove the master 
and insert the copy. An untitled Word file will appear. 

Pull down the File menu and select Page Setup. Check 
Wide Orientation. With three columns we need all the 
space we can get, so change the margins to 1/2 inch on both 
the left and right (see figure 7.51). Check OK. 

As usual in boxes with text within dialog boxes, you 
can edit it in the normal Macintosh way, see 1.3. 

Paper. ® US Letter 0R4 Letter 

OUS Legal 

Orientation: 0 Tall 

0 International Fanfold 

0 Tell Adjusted ®Wide 

Margins: 

Left: ~ Right: ~ 
Top: ~ Bottom:~ 

Gutter: ._I o_· -----' 

Figure 7.51 Page setup dialog box showing correct settings for horizontal, 
three-column printing 

Pull down the Document menu and select Division 
Layout. The Division Layout dialog box will appear. 
Check Column and change the number of columns from 1 
to 3. Check OK. 

.._ ... ,_ .. 
: Diuislon Layout I OK J : 

Brealc ,_Page Number Format-
0 Continuous ®Numeric ( Cancel ) 
®Column 0 Roman (upper) 
OPege 0 Roman (lower) ~Footnotes Appea::-1 
00dd 0 Rlphabetlc (upper) ® Dn Same Page 
OEuen 0 Rlphabetic (lower) 0 At End of Dlulslon 

0 Auto Page Numbering: Running Head Position: 

FromTop: ~ From Top: 

~ From Left: 7.25" From Bottom: . 
Start Page Numbers At:~ Number of Columns: 

~ Column Spacing: 

Figure 7.52 Division layout dialog box set for three-column printing 
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• li File Edit Search 

Rotlclpeted lir ewtll 

Marketing 

MeoegeRJeot 

Proll•c:t ll•e 

t•••••ll!l 
aespeDslllllltleso 

I 

Figure 7.54 Thorn & Co. brochure 
headings 
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Pull down the Character menu and select Formats. For 
the title , set the format to 20-point New York, Bold, · 
Shadow. Check OK. 

.. 

Character Formats n OK I 
Style 
181 Bold ( Cancel J 
Oltalic 
0Under1ine Position-
0Smell Ceps @ Normel 
ODutline 0 Superscript 
~Sh8dow 0 Subscript 

Font Neme: 
II Chicago 

~ ""' I Size: 
Geneue 

li'i itAIMI Monaco w 
Figure 7.53 Character Format for 20-point, bold, shadow 

The blinking insertion point will remain at the beginning of 
the file . Type "Thorn & Co." and press Return twice. The 
letters will appear at the top of the screen (figure 7.54). 

Pull down the Character menu again and select Formats. 
Set the Character Format to 12-point , Chicago, Bold. 

Type the brochure headings (Financial Status, Market 
Share, Anticipated Growth, Marketing, Management, Com­
munity Responsibility, Product Line). Press Return twice 
between each heading. When you finish the screen should 
look like figure 7. 54 . 
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Jlaaacial Slatas 
I 
Martel Sbare 

Figure 7.55 Setting the blinking 
insertion point to 
enter text 
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STEP3 

STEP4 

Flaaaclal Status 
Text text text text text text text 
text. Text text text text. Text text 
text text text text text text. Text 
text text text text text. Text text 
text text text. Text text text text 
text text. 
Martel Sbare 

Figure 7.57 Dummy text for the 
brochure 
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Dummy Text 

We will use dummy text to fill out this brochure 
instead of actually writing out material under each heading. 

Set the insertion point between Financial Status and Market 
Share. 

Pull down the Character menu and select Normal (to turn 
off bold). 

Pull down the Character menu and select Formats. When 
the Character Formats dialog box appears, select tO-point 
Geneva. 

The steps in the previous section defined a three­
column format drawn horizontally across an eleven-inch 
piece of paper. That means each column is three inches 
wide. When you print the brochure it will appear in three 
columns, but on the screen you only see one column at a 
time. 

lt---------11;;...." -----------.; 

8.5" 
J, 

Figure 7.56 Basic design of the Thorn and Co. 

Type "Text" repeatedly to create a paragraph of dummy 
text. Because it is part of a column three inches wide, it will 
only appear on the left-hand part of the screen. 
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STEP2 

STEP3 

STEP4 

Copy the paragraphs of dummy text below l\Aarket Share, 
Management, Product Line, and Community Responsibil­
ity. 

Copying a Figure from a Commercial Clipsheet 

T /Maker offers diskettes under the name of ClickArt 
that provide useful, predrawn images that can be used in 
MacPaint. To use them you copy the image onto the Clip­
board and paste it into the text. In order to see the picture, 
you must have a copy of the MacPaint program available, a 
somewhat complicated process if you have only one disk 
drive. 

Thorn & Co. has chosen an image that is tall, slender, 
and noncontroversial. 

Pull down the File menu and select Quit. The file-saving 
dialog box will come up. Type "Thorn Brochure" and 
check OK. 

Pull down the File menu and select Eject. 

Insert a diskette that has the System Folder and Mac Paint on 
it. Then Eject it. 

Insert the ClickArt diskette. When the catalog appears, 
double click on a folder named Stuff. When the folder 
unfolds, double click on a MacPaint file named Americana 
(figure 7. 58). The Mac will eject the ClickArt diskette and 
display a message to insert the diskette with MacPaint on it. 
Do so. 

After several switches between the two diskettes, a 
collection of Americana will appear, including Wash­
ington, Lincoln, and the Liberty Bell. (If you have two 
drives, one can hold the ClickArt diskette and the other the 
diskette with MacPaint on it.) 

littt. ~s 8i9g.,. !IIIIlS Good C)UllS Mon littt. guv li!l!: 

J~ .L I 
Figure 7.58 Selecting Americana from the ClickArt Stuff Folder 
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Figure 7.59 Selecting Show Page 
from the MacPaint 
Goodies menu 
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Each MacPaint file can hold one printed page of pic­
tures , but the screen shows a smaller area. MacPaint has a 
command that shows you the whole page called Show 
Page. 

Pull down the MacPaint Goodies menu and select Show 
Page. 

Figure 7.60 is the full view of the page. Naturally , 
details are lost. The dotted rectangle shows where the 
screen lies. Touching the end of the cursor arrow to the 
edge of the dotted rectangle and pressing the mouse button 
lets you drag the screen to a different location. 

Figure 7.60 The Show Page view of Americana 

Drag the dotted rectangle until it includes the Statue of 
Liberty. Then click OK to return to a close view. 

To the left of the art area in MacPaint are the symbols 
of tools (as in MacDraw). If your statue is not showing 
completely you can move it by selecting the hand tool; the 
cursor turns into a hand. Move the hand into the picture, 
press the mouse button, and you can move the picture ''by 
hand. '' The rectangle at the top lets you copy things. It is 
called the marquee, because in action it produces a jiggling 
rectangular boarder like the lights around a marquee. 

Roll the cursor into the marquee and select it (figure 7.61). 
When you move the cursor into the image area, it turns into 
a cross. 
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Figure 7.61 Selecting the Marquee tool in MacPaint 

Set the cursor above and to the right of the Statue of Liberty 
and drag it diagonally down and to the right to generate a 
rectangle around it. 

iD Rmerlc11n11 -

Figure 7.62 The Statue of Liberty selected in MacPaint 

Pull down the Edit menu and select Copy. 
The Statue of Liberty is now on the Clipboard. 

Pull down the File menu and select Quit. Pull down the 
File menu and select Eject. 

When the Mac has ejected the diskette with MacPaint on it, 
insert the Word diskette with the Thorn Brochure file. 
When the catalog appears , open up the Thorn Brochure 
file . 

Set the insertion point in the blank space between Financial 
Status and the top of the page. Pull down the Edit menu and 
select Paste. The Statue of Liberty will appear. You will 
just be able to see the top of Financial Status at the bottom 
of the screen. 

Quit and save the changes. 
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Dall1 Gallery 
lun·1 Undo :•:l 
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l'os1 e <lnd link 
Unlink ... 

Show Clipboard 

Figure 7.63 Copying a selected 
chart 
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Copying a Chart From Chart 

Eject the Word diskette and insert the Chart diskette that 
contains the Thorn & Co. chart. Select the Thorn chart. 

The chart has to fit in a three inch width, so we want to 
make it as narrow as possible. This can be done partly with 
Chart and partly through editing in Mac Paint. 

Pull down the Chart menu and select Delete Legend to let 
the chart fill up the space. 

Pull down the Chart menu and select Select Plot Area. 
Black squares will appear to show that the plot is selected. 

Pull down the Edit menu and select Copy Chart. 
The Copy Chart to Clipboard dialog box will appear. 

The preset choice is As Shown on Screen. 

Copy Chart to Clipboard 

Figure 7.64 The Copy Chart to Clipboard dialog box 

Check OK to accept the preset choice. The Chart is now on 
the Clipboard. 

Pull down the File menu and select Quit. The dialog box 
will appear that asks if you want to save changes. Check No, 
leaving the chart the way it was before you hid the legends. 
Pull down the File menu again and select Eject. 

Insert a diskette with MacPaint on it. Select the MacPaint 
icon to create an empty MacPaint file . 

Pull down the Edit menu and select Paste. The chart will 
appear with the marquee flashing around it. Move the cur-
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Figure 7.65 Selecting the 
MacPaint eraser 

STEP10 

STEP11 

STEP12 

STEP13 

STEP14 

sor anywhere outside the marquee area and click the mouse 
to stop the flashing. 

The dollar values on each side of the chart take up 
space, and could be replaced with text. The tools in Mac­
Paint include an eraser; it is the fifth sympol down in the 
column of tools next to the screen. 

Click in the eraser tool to select it. 

When you have chosen the eraser, the cursor will turn 
into a white square when it is in the image area. Pressing the 
mouse button lets you use the white square to erase any­
thing it touches . 

Erase the numbers on the sides of the chart. 

\0 .00 

0 .00 

Doll~rs 

198~ 1986 

./- Yu rs 

Figure 7.66 Erasing in MacPaint 

When you have erased the dollars at each side, select the 
chart with the marquee tool as above. Pull down the Edit 
menu and select Copy. The edited chart is now on the 
Clipboard. 

Pull down the File menu and select Quit. 

The dialog box that asks if you want to keep changes will 
appear. Check Yes, and your edited chart will be stored on 
the diskette in case the power fails during subsequent steps. 
A dialog box will appear that asks you to name the file; type 
"Edited Chart" and check Save. 

Pull down the File menu and select Eject . Insert the Word 
diskette with the Thorn Brochure on it. Click on the Thorn 
Brochure icon. 
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Figure 7.67 The Chart in place 
under Anticipated 
Growth 
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Set the insertion point on the blank line between Antici­
pated Growth and Marketing. Pull down the Edit menu and 
select Paste. The Chart w ill appear. 

Copying a Table from Multiplan 

Eject the Word diskette and put in the Multiplan diskette 
that carries the Thorn & Co. table . 

As in the case of the chart , we need to do some editing 
to make the table fit into the three-inch column. All the 
editing is possible inside Multiplan . The first step is to 
remove the odd cents from all the columns. 

Select the profit figures . 

... ........ ... . ... . -··· ·········· ........... . . . 
.......... : ... ........ ·-· ·· . -···· ······· ····=········· 

···:·· · ··············:········· 

Figure 7.68 Selecting the profit figures of Thorn & Co. for editing 

Pull down the Format menu and select No Decimal. 

Select the cell that contains Cost of Goods and type ''C of 
G"; press Return . 
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19M 1965 1966 I 
967 
sates 100 110 12 1 I 
33 
c of G 50 53 55 5 
6 
Profit 50 56 66 7 
5 

Figure 7.70 The Thorn & Co. 
profit table before 
reduction 
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Select the part of the table to be copied. 

Th & c P f it Forecast 
• l • - • ~ ~ • ' 

~ ' . - . 

,. :. : :: +. :, 

Figure 7.69 Part of the profit forecast selected to be copied to the Clipboard 

Pull down the Edit menu and select Copy. The edited table 
is now on the Clipboard. 

Pull down the File menu and select Quit. The dialog box 
will appear to ask if you want to save changes. Check No to 
leave the table the way you found it. 

Eject the Multiplan diskette, put in the Word diskette, and 
open the Thorn Brochure file . 

Fix the blinking insertion point below the chart, pull down 
the Edit menu and select Paste. 

The table will appear distorted because not all the text 
will fit on the line. 

Select the whole table. Pull down the Character menu and 
select Formats. On Formats , select 9-point type. 

The table will appear in the smaller type. The bro­
chure is now ready to print; the final version should look 
like figure 7 . 71. 
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T E R E G H T 

Databases do not come from as clear a model in the 
noncomputer world as word processors and spreadsheets. 
Word processors, at least in the beginning, had the mode of 
a magic typewriter, and spreadsheets had the model of a 
magic accountant's ledger. If data bases have a mode it is 
based on a file drawer filled with identical forms. 

Computers are good at storing and fetching such infor­
mation, and data bases have been with us on large, imper­
sonal computers for many years. When we make an 
airplane reservation, the person behind the counter sees on 
her or his screen the image of a form retrieved from a data 
base, and when the ticket is printed, it is part of that data 
base in a different format. When we buy a ticket from 
Ticketron, the image of the theater is a data base and the 
printed ticket is an image from that data base. When a 
police officer stops one of us in traffic and radios in our 
license number, someone at headquarters searches a data 
base. 

The computer searches quickly and efficiently 
because it is able to see information arranged in several 
orders simultaneously, allowing it to search as fast for one 
thing as for another. 

PFS:file, the second program described below, allows 
you to create an old-fashioned computer data base for 
yourself. It allows you to design a form, fill in information 
on as many copies as you like, and then print or display the 
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forms. You can also print lists of single items from the 
forms, say all the people named Smith in a personnel file. 

Filevision, the first program discussed, takes a new 
approach. The information is organized on a diagram. You 
essentially pin the forms to places on the diagram. Will a 
graphic approach help you? It depends partly on your data: 
do they suit a diagram? Are they, for example, based on the 
locations of things (e.g., a map is a powerful organizing 
image). It also depends on how your mind works; if you 
tend to think in pictures, Filevision might suit you. 

Factfinder, the third data base program discussed, fol­
lows a somewhat different model. The model for Fact­
finder is notes, such as those a student takes on 3-by-5 cards 
before writing a big paper. This model has also been around 
on big computers. There are several services (Dialog is one 
and Orbit is another) that essentially offer the index card­
file of a library and allow you to search through the file 
with specific words or phrases, called keywords. One vir­
tue of Factfinder is that you can write unconstrained by a 
rigid format like a form, which most data bases require. 

It will be useful in understanding how these three 
programs work-though not necessary to using them-if 
you understand three terms from computer jargon: field, 
record, and file. You hear these terms quite a bit in conver­
sations about programs and see them in computer text­
books, but there are not generally accepted definitions. So 
the somewhat rough and ready definitions below are as 
good as any. 

Afield is the computer equivalent of one box on a form, 
say last name, zip code, or serial number. 

A record is the computer equivalent of the whole form. 

A file is the computer equivalent of the drawerful of files; 
it is all the forms you can search in one pass. 

The designers of Filevision had the novel idea of using 
diagrams as a way of organizing information. In setting up a 
Filevision data base, you first draw, or borrow, a diagram 
and then attach nonvisual information, such as forms, to 
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parts of the diagram. This idea, which suits the Macintosh 
so well, came to the Filevision programmers before they 
knew about the Macintosh. Imagine their delight when just 
the machine to support it appeared on the market. 

Starting From Someone Else's Pictures 

As with most data base systems, in Filevision you 
spend a lot of time setting things up; you reap the rewards 
only over the following weeks, months, and years. In par­
ticular, in Filevision you have to make a diagram before you 
do anything else. Drawing in Filevision is 80% the same as 
drawing in Mac Draw. To save going over the ground in 
chapter 3, this exercise will adapt a map of the United 
States, which comes as an example on the Filevision disk­
ette. At the end of the exercise you will add a state to the 
United States, which will illustrate the basics of drawing in 
Filevision. 

Filevision uses the same sort of copy prevention 
scheme that Microsofts Word and Multiplan use. You can 
copy the diskette you buy from them, but when you use it, 
you must put the master diskette in briefly at the beginning 
of the session. 

Filevision Basics 

Copy the Filevision master diskette onto a blank diskette, 
including the System Folder, the applications icon, and the 
file called Map. (Space is pretty tight on a Filevision disk­
ette. If you are not working with two drives, you will 
probably want to remove some of the more stylized fonts 
such as Venice or London from the System Folder on your 
copy diskette.) 

Insert the copied diskette into the Mac and turn it on. When 
the catalog appears, click on the Filevision document Map. 
As Map is appearing, the Mac will prompt you to insert the 
Filevision master diskette for a moment. 

A map of the US, a set of menus, and a stack of tools, in 
the left margin, will appear. The tools are much like those 
in MacDraw or MacPaint. 

The Map file holds information about each state and a 
hypothetical chain of offices. The offices won't interest us, 
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Figure 8.1 The Filevision Map 

but we will use the states. To get a sense of how the 
programs work, let's look at the information attached to 
one state. 

Pull down the Types menu and select State. 
Note that State appears on the menu of this file, but not 

on Filevision menus in general. The person who drew the 
map defined State as a type and so it got a place on the 
menu. You will learn how to do that below. 
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Roll the cursor into Texas and click twice. The information 
screen for Texas w ill appear. 

lnformet1on for this St ele: 

Figure 8.3 The information screen for Texas 

Pull down the Tinker menu and select Highlight Some. 
The conditional highlighting screen w ill appear (fig­

ure 8.4). ln this graphic data base system the screen where 
you decide what stands· o ut on the diagram is also the 
screen where you decide what information you want . 

Figure 8.4 The conditional highlighting screen 

Check the box beside COMPUTER STORES. The heading 
on the right will change to COMPUTER STORES. 
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Check the box with :5 (equal to or less than). Type " 100". 
When you type on the left, the text also appears on the 

right. 

Check the box under the first And. You will see the lines 
that show which parr of the form you are changing shift to 
the box under the second And. This shift is an excellent use 
of the visual, interactive quality of the Mac to show you 
what you can do. 

Check COMPUTER STORES and ~ (greater than or equal 
to) and type " 6". The screen will now look like figure 8. 5. 

Figure 8.5 Setting up to show states with 100 or less and 6 or more computer 
stores 

Check Done. The map will appear with the proper states 
highlighted. 

Figure 8.6 States with 100 or less and 6 or more computer stores 
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According to Filevision, in 1984 only one state had less 
than 6 computer stores. Try your hand at finding which. 

Deleting Unwanted Types To find out about an office 
click on one of the diamonds, which are symbols of offices. 
In any case, these germane to our task. 

STEP 1 Pull down the Types Menu and select Office. 

STEP 2 Pull down the Tinker menu which now rules the type 

Figure 8. 7 Selecting Highlight all 
from the Tinker menu 

STEP3 

STEP4 

Office because you just selected it. Select Highlight all. 
The states will fade and the offices will be highlighted. 

'!..''' ·--~ ~ y 

Figure 8.8 Offices highlighted 

Pull down the Edit menu and select Clear. 
A dialog box will appear that points out that if you 

clear all highlighted objects you cannot undo the action. 

You ere about to clear all highlighted objects. 

Yo\wlll not be able to undo this ec:tlon. 

HF=!!!!!OK~'J 

.;.v ,0 o ot< 0 0 o,. 0 -· 0 0 o ·r 0 -0 0.,.. . ., ,... ;.-

Figure 8.9 This dialog box warns you that clearing highlighted objects is 
irrevocable 

Check OK. 
The map will appear without the symbols for Offices. 

Although there are no more offices, the type office still 
exists and you can create a new office at any time. 
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Figure 8.10 Selecting the asterisk 

from the Symbols 

menu 
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Figure 8.11 The cursor turns into 
the symbol you have 
selected 

STEP3 

Figure 8.12 Setting the symbol on 

the map 
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Pull down the Types menu and select Delete. Since the 
Office type is still the selected type, the system will delete 
it. 

A dialog box will ask if you really want to delete the 
type Office and all objects of that type. Check OK. 

Adding Symbols 

Headquarters. The headquarters of Thorn & Co. is 
Atlanta. 

Pull down the Symbols menu and select the asterisk. 

The asterisk will appear on the left in the stack of 
tools. It is now a tool you can use to add to your data base. 

Filevision provides a small graphics editor, oddly 
located on the File menu, where you can design your own 
symbols so long as they are small enough to fit in the boxes 
in the Symbol menu. 

Roll the cursor into the new asterisk tool you have selected 
and click the button. The tool is selected. When you move 
the cursor away from it, you will see that the cursor 
becomes an asterisk. 

Roll the mouse so the tool is in Georgia. Click the mouse 
button. The asterisk will stick where you clicked with a box 
around it to show highlighting and the cursor will turn back 
into an arrow. 



198 MACINTOSH 

STEP1 

STEP2 

STEP3 

STEP4 

Adding Suppliers As a Type 

Pull down the Types menu and select Add Another. The 
Type Definition dialog box appears. 

Definiti on for this type: 

Figure 8.13 The Type Definition dialog box 

Now we will define a new type of data: suppliers. We 
will set up some fields that define what sort of information 
Thorn & Co. needs to keep about suppliers. We will create 
these fields by defining boxes for this information and 
labeling the boxes with the type of information to be filled 
in. 

Move the cursor into the box next to Type-name; the cursor 
will turn into an 1-beam to show you can insert text. Type 
"Suppliers" . 

Name and Link appear in all Filevision data items. 
Name will be the name of each supplier. Link allows you to 
link information from other Filevision files. 

Move the cursor to Add Field and click the mouse button. 
The click will confirm that you have named this type of 
item "Suppliers"; no Return is necessary. 

The Add Field button changed to Where? Move the cursor 
into the gray area; note that when it enters the gray area it 
becomes a pointing finger; this indicates that it can be used 
to fix the location of the next field. 
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Type " Address" . By touching the stretching handle with 
the point of the cursor and holding down the mouse , pull 
the Address box until it has enough space for an address. 

Figure 8.14 The data file ready to be named 

The Add Field button has turned to Copy Field. Click twice 
in the gray area and by similar steps create a City field. 

Add fields until the type definition box looks like figure 
8.15. Check the Done box. 

Def tnt t1on for thi s type: 

Figure 8.15 The type definition for suppliers 

Pull down the Symbols menu and select the large dia­
mond. It will appear on the tool stack at the left margin. 

Select the diamond from the tool stack. When the cursor 
slides into the work area it becomes a diamond. Move the 
diamond into Massachusetts and click to fix it there. 

Click Info . 
The blank you have designed will appear. When you 
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lnformolion for this Suppliers: 

Figure 8.16 Blank suppliers form 

move the cursor into any of the boxes , it will turn to an 1-
beam and you can type and edit in the boxes. 

Fill out the information so the form looks like figure 8.17. 
Then check Done. 

Create two or three other suppliers to give substance 
to the printing below. Sample information on three hypo­
thetical suppliers of Thorn & Co. appears on page 208. 

lnformolion for this Suppliers: 

Figure 8.17 Information about a particular supplier 

Creating An Object 

Pull down the Types menu and select State. 

Pull down the Lines menu and select the second fattest 
line. Select the freehand drawing tool at the bottom of the 



Figure 8.18 The state of Atlantis 

STEP3 

STEP1 

Three Different Data Base Programs 201 

tool stack. Draw a large island off the southeast coast as in 
figure 8.18. 

When you enclose the island, the pattern that is cur­
rently selected (here the stipple that fills the states) will find 
the island . Be sure to join your line to the starting point 
smartly so the pattern will fill. 

The island is now an object and you can attach infor­
mation to it just as you attached information to the symbols 
of the suppliers. 

Click on Info. A blank state information form will appear . 
Fill it out as in figure 8.19. 

Now Atlantis will appear in all the operations you do 
on states. For example, if you select Arkansas and click the 
Next button, Atlantis will brighten because it is next in 
alphabetical order. 

Information for this Stale: 

Figure 8.19 Information about Atlantis 

Printing 

Pull down the File menu. 
Print display prints exactly what you see on the 

screen. If highlighting is on, the objects are highlighted on 
the printed page. 

Print info prints the info displays for any number of 
items of the current type. It also allows some page format­
ting, page numbers, a running head, and running footer. 
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Figure 8.20 Printing in Rlevision 

Print list allows you to print a list of selected informa­
tion about the items of the type currently selected. You 
could, for example, print a list of the population of every 
state. 

Print labels allows you to design and print small 
labels such as mailing labels. 

Let's print labels. Select Print labels for this example. The 
Print label dialog box will appear. 

Figure 8.21 The Print label dialog box 

The preset label size is fine for this exercise but you 
could change the size of the dotted box by dragging the 
little black square handle on the lower right. The preset 
order of printing is alphabetical by name, but the Post 
Office requires that bulk mail be sorted by zip code so we 
will change it. 
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Click on the little double arrow at the right end of the Order 
printing based on box. The names of other fields you have 
created will pass as you click. Stop on zip. 

The preset label includes Link, which is not part of a 
mailing label. In the preset layout Link stands selected, 
which is shown by the handles and the line that leads to it 
from the format control box. 

Click on Remove Field. This step merely removes link from 
the label, but not from the system. 

You need the city, state, and zip on the mail label. Click on 
the Add Field button, it will turn to Where? As before, 
moving the cursor to the work area turns it into a pointing 
hand. Move the hand below the Address field and click. A 
field will appear there, but it will not be the City field. Click 
the little doubleheaded arrow in the format box, bottom 
center, and you will see the fields you have created pass 
before you. Stop on City. Adjust the field's location with 
the black, top-handle and its length with the black handle 
on the lower-left corner. 

Add the State field and Zip field so the label on looks like 
Figure 8.22. 

Figure 8.22 Filevision Print Labels dialog box ready to print 

Check Done. The regular Mac printing dialog box will 
appear. 

If you want gummed labels you have to load your 
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printer with them. They are available in most office supply 
stores on narrow waxed rolls. Insert them on the left of the 
platen, lined up with the small red line on the bail. Be sure 
to open the lever on your printer that allows for extra thick 
paper; if you don't, gummed labels can jam in the works of 
the printer, which is a hell of a mess to fix-believe me, I've 
done it. 

Check Continuous if you have a roll or a fanfolded labels, 
and low or high quality. Most mailing labels I see use a 
lower-quality printing than is available on a Macintosh. 

While you are printing, a box will appear that counts 
the number of labels you have printed. The labels will look 
like this: 

Ahab Whalebone 

431 Marble Road 

Cummaquid MA 

02637 

Hetera Hatties 

816 baleen Ave 

Ce8tonvi11e NC 

27588 

Mendocino Whites 

565 Front Street 

Mendocino 

Big Fleet 

CA 

94460 

4 t 2 State Street 
Bellingham WA 

98225 
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PFS:file runs on the Macintosh very much like it runs on any 
personal computer. The only difference is you locate things 
with the mouse instead of cursor buttons and you pull 
down menus instead of seeing them flash on the screen. 

PFS:file is one of the most widely used applications in 
personal computing. There are others that are more power­
ful and more flexible, but they are harder to use for the 
nonprogrammer. PFS:file is easy for the noncomputer per­
son to get hold of and is quite satisfactory for many applica­
tions, such as the personnel records of a small firm, parts 
lists, and other inventories. It has more sophisticated ways 
to search and filter than does Filevision. The amount of 
information you can deal with varies with the size of the 
individual forms and some other factors, but it is surpris­
ingly extensive on a Mac. You can store and search nearly 
3, 000 of the simple forms used in the examples below. 

The style of PFS:file and PFS:report are rooted in the 
old system of rows of clerks in open office environments 
typing data onto on-screen forms while programmers 
extracted from that data lists that other people read. These 
programs allow you to do those functions yourself. You 
can print a single form directly from PFS:report, but to 
extract lists or other different views from your data you 
need the second program, PFS:report, which comes on the 
same diskette. With PFS:report you can create various for­
mats and do some mathematics to extract new information 
from the source data. For example, in a parts list PFS:report 
can multiply the number of parts in stock by the price and 
give the value of inventory of each part; and it can total the 
whole column to give the total value of the inventory. 

The examples use the same information about the 
suppliers or Thorn & Co. as did the examples of Filevision. 

How PFS:file and PFS:report Work 

In PFS:file you design a report by fixing headings on 
the screen for your information. You make as many copies 
as you want of this blank form and fill in the information for 
particular subjects. You search for forms by calling up the 
blank form and entering the text you are searching for. You 
can print, copy and remove forms in the same way: by 
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identifying the form with a piece of text that appears in it. 
In PFS:report you number the fields you have defined 

and then all the items in that field will print in a column 
with that number. Or you may filter out forms and print 
only the items from the filtered forms in the numbered 
columns. You can add tags to the design of your printed 
report that will total, subtotal, and average the columns, 
and generate new columns by, for example, multiplying 
two of the old columns. 

Creating a Form 

Put the PFS diskette in the Mac and start up; click on the 
PFS:file icon if necessary. 

A dialog box will appear that asks you if you want to 
start a new file, see an old file, or quit (No, I don't know 
why you should want to quit at this point). 

Click on New. 
A dialog box appears (figure 8.23 ), which asks for a file 

name and offers you the chance to eject the diskette. If you 
eject the diskette you can insert an empty diskette and 
create your file there. A second diskette will give you more 
space and save wear on the master diskette, which you 
can't copy. You will have to reinsert the system diskette 
from time to time to let the program read itself. This simple 
example will fit on the PFS master diskette. 

Type: "Thorn & Co. Suppliers" and check OK. 

New file nome 

I Thorn & Co Suppliers 

Ok ( cancel I 

Figure 8.23 The New file dialog box 

PFS progrom 

( Eject 

Now you design your own form by putting in headings 
where you want your information to go. When you begin 
the screen is a blank sheet. You can click with the mouse 
anywhere on the screen and begin typing. Response to the 
click may be a little slow while the program locates the 
right point. Type headings. End each heading with a colon. 
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Data will go on the individual forms after the colon. When 
you have designed the form you can edit it with the usual 
Macintosh tools . 

ved? : ~w~• s 

Ha.e : 
Address : 

Cil11 : Stale : 
Phone : 

02631 

1 

... d ? , - ·~--

'"·d? : no

1
-­

Racaivad? :f----'r---_ Filled in 

Z ip : 

nont.hl\1 S h i p : 
O•ed : Due : Forms 
Co-.:nls : lanlc Form 

Figure 8.24 First design a form 

Layout the design as in figure 8 .25 . 

' * File Edit Functions Formats 

Thorn & Co Suppliers 

Fill In page I of the design. 

No•• : 
Address : 
C i ty : State : Z i p : 
Phone : 
Month l \,1 Sh i p : Rec:e i ve:d : 
Owed : Due Dote 

Coa111ent s : 

Figure 8.25 Thorn & Co. suppliers form in PFS-file 

Putting in Information 

Pull down the Functions menu and select Add forms. All 
the headings you created in the design will turn bold to 
show that this is the master form. 

Type '' Ahab Whalebone'' . Press Tab to move to the next 
item. Type in the information found in figure 8.26. 
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n-: ~hab llhalebone 
Address: 43 I narb 1 e Road 
Cltv: Cu11111aquid State: nA Zip: 02637 
Phonct: 617-363-7070 

=~·r ~~~P= 2000 ::e~~ ~~12' r 

Figure 8.26 The Thorn & Co. suppliers form filled out for Ahab Whalebone 

Enter information on three more suppliers so we can see 
how PFS:file searches and filters data. When you finish the 
Ahab Whalebone form, check the Continue Adding button 
to get a new, blank form. The information on three sup­
pliers follows: 

Name: Hatera Hatties 
Address: 816 Baleen Ave 
City: Ceatonville State: NC Zip: 27588 
Phone: 919-556-2940 
Monthly Ship: 3300 Received: no 
Owed: 0 Due Date: 0 

Name: Mendocino Whites 
Address: 565 Front Street 
City: Mendocino State: CA Zip: 94460 
Phone: 707-897-3831 
Monthly Ship: 2100 Received: yes 
Owed: 1987 Due Date: 

10/31 

Name: Big Fleet 
Address: 412 State Street 
City: Bellingham State: WA Zip: 98225 
Phone: 206-743-9178 
Monthly Ship: 2043 Received: yes 
Owed: 2345 Due Date: 

I 1111 

Searching for Forms 

When you finish filling out the forms for the suppliers, 
the form for Big Fleet should occupy the screen. 
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Pull down the Functions menu and select Find forms . 

formots 

Print this form 
Remoue this form 

Copy forms 
Copy design only 

Figure 8.27 The PFS:file Functions menu 

The screen will return to the blank form you first 
designed. PFS:file creates a second command and feedback 
area beneath the menu headings. The Find forms button 
will appear to the right of this area. 

a File Edit Functions Formots 

Thorn & Co Suppliers ----- ----
- -- ~~-- -

Page 1 -- pleose choose forms to find. 

ttoae : 
Address: I 

Figure 8.28 The Find first form button and command feedback area 

If you click on the Find first form button, the last form 
you created will appear and the button will change to Find 
next form. By clicking on it, you can leaf through the forms 
one by one, a useful approach if you have 4 forms, but not if 
you have 100 or 1,000. 

If you have leafed through your forms , pull down the 
Functions menu and select Find forms again. The blink­
ing insertion point will appear after the first item, Name:. 
Type "Ahab Whalebone" and click on the Find first form 
button. 

The whole form for that company will appear. When 
you type the complete text of any item in the blank and use 
the Find first form command, the system will find any form 
that matches that text. 

If more than one form matches, PFS:file will show the 
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first one first and you can then leaf through the other 
matching forms with the Find next button. 

Set the insertion point after Received?:. Type "yes" and 
click on the Find first form button. 

The program will search for suppliers that have deliv­
ered that month. The first to appear will be Mendocino 
Whites. If you click on Find next form, the form for the 
other supplier that has delivered, Big Fleet, will appear. 

In a real business file with hundreds of forms, you 
might not know exactly how an item was written; in that 
case you can use periods to represent uncertain characters. 

Select Find forms on the functions menu to see a blank 
master form. Set the insertion point after State:. Type 
'' .. C .. '' and click the Find first form button. 

Two suppliers are in states that have a C in their 
abbreviation, Mendocino Whites in California and Hattera 
Hatties in North Carolina. Mendocino Whites will appear, 
and clicking the Find next button will show Hattera Hat­
ties. 

You can also compare numbers. For example, you can 
use the mathematical sign > (greater than) to search out 
numbers over a certain size. 

Select Find forms on the Function menu, set the insertion 
point after Owed: and type '' > 1000' '. Then check the Find 
first form button. 

The form for Mendocino Whites will appear, the sup­
plier to which Thorn & Co. owes the most money. Clicking 
on the Find next button will show in descending order the 
other firms that Thorn & Co. owes more than $1,000 to. 

Before you begin the next steps devoted to printing, 
pull down the File menu and select Quit PFS:itle. 

Printing 

Within PFS:file you can print sections of the forms as 
they appear on the screen. PFS:report allows you to print 
the information rearranged into columns of similar items, 
and to do some calculation on those columns to create new 
columns, totals, averages, and the like. 
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Click twice on the PFS:report icon. A dialog box will appear 
that asks you if you want to open a PFS data file or Quit. 

Click on Open. 

Select ''Thorn & Co. Su ... '' (the system abbreviates the long 
name) and then check OK. 

A blank screen labeled with the file title will appear 
with the message "Please make a menu selection." 

Pull down the Formats menu and select Create a report 
format. 

A dialog box will appear where you can write the 
name of the report format. 

Type "Owed'' and check OK. 
Items are marked for printing by typing after the colon 

the number of the column you want them to appear in, 
counting from left to right. 

Set the insertion point after Name: and type "1". Then set 
the insertion point after Owed: and type '' 2''. 

You can total, subtotal, and average the columns you 
have defined using the symbols T, S, and A, respectively, 
after the column numbers. 

Add A and T to match figure 8.29. 

Thorn & Co. Suppliers 

Edit page 1 of the report format ·owed". 

City: 
PhOfte: 
nonthly Ship: 
O.ed:2AT 
c-ents: 

I 
State: Zip: 

Received?: 
Due Data: 

Figure 8.29 Report format screen set up to show the names of suppliers, the 
amount owed, the average, and the total 

Pull down the Functions menu and select Print a report. 
A blank version of the report you designed will appear with 
the message ''Please choose forms for the report.'' 

At this point you could select certain forms with the 
same tools you used to select certain forms for display in 
PFS:file. In the case of this small example, let's select items 
from all the forms. 
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STEP9 

STEP10 

" • File Edit Functions Formats 

Report Title 

I Money Owed to Suppliers 

Check the Print report button. 
The report printing dialog box will appear. We will 

print to the screen, but you could print the same report to 
paper, or store it on the diskette for future printing. 

Fill out the report printing dialog box to match figure 8.30. 
The report will look like figure 8. 31. 

t1one1.1 Owed to Supp I i ers 

tta11e Owed 

Ahab llha I obona I, 379 
Big Fleet 2,345 
Ha ltera Ha tt i es 0 

Print to 0 Printer ® Screen 0 Dlsle File 

0 Pause between pages t1end i c: i no llh i tas 1 , 987 

Lines per page ~ Page width ~ Average: 1, 428 
Total: 5, 711 

Printer codes 

0 Don't use predefined report format 

®owed 
Figure 8.31 Thorn & Co.'s debts to 

suppliers 

~ 
Ok ~( -Ca-n-ce-1....., 

Figure 8.30 Report printing dialog box set to print to the screen 

Factfinder 

You can also set up columns in PFS:report based on 
calculations from other columns, for example, the number 
of parts and the price might be in the original report and the 
value of the inventory could be a separate column on the 
printed version. 

Unlike Filevision and PFS:file, Factfinder is built to give you 
power over your notes. Although you can do some things 
with numbers, it is basically a way of storing text informa­
tion, much like an electronic 3-by-5-inch card; moreover, 
you search and print the notes that contain certain words. 

Because Factfinder works best on regular text, the 
following exercise (p214) does not regroup the Thorn & Co. 
suppliers but show arranging and retrieving a few refer­
ences for the college paper on The Universe discussed in 
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chapter 7. If you have not looked at chapter 7, it would 
probably help you to at least glance at the outline. of ''The 
Universe'' presented there. 

Factfinder does not let you copy the program to 
another diskette. You can get one free backup diskette 
from the manufacturer by sending in the warranty card. 
You can copy the program to a hard disk. It does give you 
the very limited ability to copy the program to other disk­
ettes, but the copy will only allow you to have 16 items in a 
list. Such copies are useful only as advertisements for Fact­
finder. This copy prevention leaves the user that has only 
one drive with an awkward choice: You can keep your files 
on the master diskette and have up to 50 one-page fact­
sheets, but you will be wearing out your irreplaceable mas­
ter diskette. Or you can put the data files on a second 
diskette, where you can have hundreds of one-page fact­
sheets, but you shuffle diskettes in and out often. 

Factfinder has, unfortunately, invented its own little 
terminology. I said that it is like keeping a file of 3-by-5 
cards on your diskette. The cards are called "factsheets" 
(variable-length records in data processing terms) and the 
whole bunch together is called a stack (a file in data process­
ing terms). There are some other odd terms on this program 
which make learning it a little slower, and writing about it a 
little more difficult, but they do not get in the way of using 
the program once you get the swing of it. 

How Factf1nder Works 

When you evoke the application the first time, you see 
a group of windows. On the left is a window called the 
factsheet, where you can type about 6 pages of text. You 
can expand this window to fill the whole screen if need be. 
A group of such factsheets that are filed and searched 
together are called a stack. You can select words or phrases 
in the factsheet by normal Macintosh selecting and they 
will appear in a window on the left, which keeps track of 
them. In another window you can type or copy these 
words and the system will show or print all the factsheets 
that contain them. Factfinder generates an index where 
you can find all the keywords for a file in case you want to 
review them. 
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STEP1 

STEP2 

Figure 8.32 Selecting Create 
Stack on the 
Factfinder menu 

STEP3 

STEP4 

STEPS 

Making a Factsheet 

Insert the Factfinder disk and click on its application to 
open it. 

A billboard screen appears that contains information 
about how much memory is available in the machine and 
how much space is o n the disk. 

Pull down the File menu and select Create Stack. 
A dialog box will ask you to name the stack, and offers 

you the opportunity to eject the diskette. 

Type ''The Universe'' and check OK. A set of blank Fact­
finder material will appear on the screen. 

' * File Edit Steck Factsheet Keys Utility Help 

I DIIii!i!!l Unnam ed Factsheet ~ Find In The Unluerse 
II IQ 

Find Fcc tsheets contcining: 

Keys for Unnamed Fectsheet 

erected on 1 1 I 1/ 64 
Modifi ed on 11/ 1/64 

I M 
Figure 8.33 What you see when you start Factfinder 

Now we can turn to putting text in the factsheets . 

Move the cursor into the factsheet window and click it to 
make the window active. The blinking insertion point will 
appear at the upper left. 

Type the fo llowing definition of the universe : " All created 
things viewed as constituting one system or whole; the 
creation; the cosmos. ' ' You can correct errors by backspac­
ing, and the normal Mac editing commands (Cut, Paste, and 
Copy) are available. 
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Figure 8.34 Selecting Change 
Name from the 
Factsheet menu 

STEP7 

STEPS 

10• Keys for Dlctlon11ry -

~Created on 1 1/5/84 
Modified on 11/5/84 

ALL CREATED T HINGS iil 
COSMOS 
CREATION 
SYSTEM 

tr; 

(@to~•~tl' l (c1e11r Ke!Js) 

II I 

Figure 8.36 The Keys for 
Dictionary window 
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Pull down the Factsheet menu and select Change Name 
(figure 8.34). A dialog box will appear to accept the name. 
Type " Dictionary" and check OK. 

You should select some keywords that Factfinder will 
later use to search for the dictionary definition. This is your 
handle on this information, so don 't be shy about selecting 
keywords. 

Select the words cosmos, creation, system, and the phrase 
" All created things" one at a time by dragging the cursor 
across them. 

You can also select a word in Factfinder by clicking 
twice, but the selection will include punctuation that is not 
separated from the word by spaces. In other words, what 
you get by double clicking is all the consecutive printing 
characters. Since you want future searches to find "cos­
mos" without having the comma as part of the keyword, it 
is better to select a word that has adjacent punctuation by 
dragging the cursor. 

Pull down the Keys menu and select Mark. 

Figure 8.35 Marking a word as a keyword 

When a keyword is marked, it appears alphabetically 
in the nearby Keys for Dictionary window. 
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STEP9 

STEP10 

STEP11 

Pull down the Factsheet menu and select New. When you 
ask to create a new factsheet , the program asks you if you 
want to preserve the changes you've made in the last fact­
sheet you worked with. Check OK. A new factsheet will 
then appear. Name it "Big Bang. " 

Type in text and select keywords to match figure 8.37. 

Scientific Amertccn 
October I 963 
Abstrcct : 
Across btlllons of llght-yecrs spcce 
Is c honeycomb of gclcctlc 
superclusters end huge voids. The 
structure mcy result from 
perturbcttons in t he density of 
metter ecrly in the big bong 

Figure 8.37 The Big Bang factsheet 

4 Fcctsheets In Steck 
4 Fcctsheets found 

Dlcttonc 

Princess Shlklshl 
Lucretius 

Create a new factsheet and then type in the poem by the 
12th century Japanese Princess Shikishi. 

1 slept In the pest. 
thct wl11 never come beck, 
cs though It wcs the present. 
Around the pillow In my drecms, 
The perfume of orenge blossoms 
flocted, 
like the frcgrcnce of the sleeves 
of the men who is gone 

4 Fcctsheets In Steck 
4 Fcctsheets found 

Figure 8.38 Quotation from Princess Shikishi and keywords 
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Some ideas are present in the poem that are not stated 
explicitly-something that happens in poetry, especially 
Japanese poetry. The speaker seems to be in love and it 
seems as if the man she loved has died. Note also that 
orange blossoms are relevant to " oranges, " one of the 
items in the outline in chapter 7, but it is not the same word. 
Here is how to supply these keywords that are not exactly 
present in the text but should be indexed. 

Click on the Keys for Dictionary window and type I I love''. 
You will see it appear in the box at the bottom. Check the 
Add button (or press Return). In the same way add " death" 
and "oranges. " Then select the other words to match fig­
ure 8.38 as you did above. 

Create a new factsheet , change its name to " Lucretius ," 
and mark some words for cataloging as in figure 8.39. 

Lucretius wrote "On the Nature of Things" about 75 
B.C. If his ideas seem to resemble the abstract from 
Scientific American, it shows that the more things change, 
the more they stay the same. 

ngs ... 
Listen carefully and I will explain 
by what motion the creative 
elements In matter make other 
elements and how after thct they 
break up end whet force compels 
them to move end the speed they 
t revel through the greet voi d. 

Figure 8.39 Quotation from Lucretius 

Finding Factsheets 

4 Factsheet s In Steck 
4 Factsheets found 

Dictionary 
Big Bong 
Princess Shlklshi 

Normally three windows besides the factsheet are visi­
ble on the Factfinder desktop (see figure 8.40). 
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STEP1 

STEP2 

!0~ Names Found ===:iii 
4 Fac tsheets in Slack 
2 Factsheets f ound 

Figure 8.41 Names found 

Find in Uniuerse 

Find Factsheets containing: 
( \/here You Pu\ Kao~vord a: lo all 

Flnd Factshe•ls 

Names Found 

4 Factsheets In Stack 
( \/he re You Choos• Vhich 1 4 Factsheets found 

facts heel l o Dis: play ) 
Dictionary 
Big Bang 

Princess Shlklshl 
IOiiii!!l Keys for lucretius lliiliiiliill 

Created on II / 2/B4 

l Vhoro You En\or Ko9vords \o }--- Modified on 11 /2/84 ~ 
lde nlif!:J Fa chhfl'ts 

MATTER 
MOTION i!o! 
NATURE 
UDID 

Figure 8.40 The Search window 

Click on the Find in The Universe window. 

Type "void " in the window. If the word " all" is in the 
window it searches for all factsheets. Double click o n " all" 
and type " void" to replace it. Pull down the Factsheet 
menu and select Find factsheets. 

The Names Found window will come to the front 
(figure 8.41). It shows that two factsheets are keyed to 
"void" and that Big Bang is selected. You could select 
Lucretius and display it. 

Click on the Big Bang factsheet. It shows buttons for 
controlling the view at the bottom. 

Figure 8.42 The Zoom, Previous, and Next Buttons on a factsheet 

Factfinder also maintains an index of the names , crea­
tion dates , and keywords of all your factsheets. You can 
look for items in the index and then use them to search. The 
index includes buttons to combine terms. 
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STEP4 

Find In Unluerse 

Find Factsheets containing: 

"UOID" and "SCIENTIFIC 
AMERICAN" 

Figure 8.44 Search for a factsheet 

with "Void" and 

"Scientific American" 
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STEP1 
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Pull down the Stack menu and select Show Index. The 
index will appear. 

~ lndeH of The Uniuerse 
KMES B/6 8AN6 
CREATE 0/CT/ONARI' 
e::~y L LICRETILIS ~ 

DATE PRINCESS SH/1(/SH/ 
DATE Creeted on 11/05/64 
JCEYS Modified on 11/05/64 

o ... 4 All CREATED THINGS 
5 ••• 9 COSMOS 
A.· .c CREATION 
D.· .F DEATH 

~:: :~ DREAMS 
n ... o LOVE 
P ••• R MAN 
s ... u MATTER 
II ••• Z MOTION 

NATURE 

Figure 8.43 The Factfinder Index window 

You Can Pick Factsh••t• by 
nam• 

You Can Pick Factshe.ts by 
Vh•n You mad• Th.ul 

ou Can Pick FactshNts by 
Vh•n You Chang.c:l Them 

Click on S ... V. The end of the index will appear. Select 
VOID and then click the move button. VOID will appear in 
the Find in The Universe window. Click on the and button; 
"and" will appear in the Find in The Universe window. 
Select "SCIENTIFIC AMERICAN" and click on the move 
button. The quotation marks separate real keywords from 
words that indicate their relation. You can insert words to 
show the relation between keywords either by writing 
them or by selecting them from the index window. 

Pull down the Stack menu and select Find factsheets. The 
Big Bang factsheet will be found. 

Printing Factsheets 

You can print a variety of information from the fact­
sheet through the Page Setup and Print items on the File 
menu; these not only do what their names imply, but also 
allow you to select what you print. 

Pull down the File menu and select Page Setup (see figure 
8.45). 
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STEP2 

STEP3 

Figure 8.46 Selecting Print on 

the Factfinder File 
menu 

STEP4 

Check items in the Page Setup dialog box to match figure 
8.45. The preset value is to print the factsheet only. There is 
no need to adjust Paper Length or Bottom Margin if you are 
using 8112-by-11 paper. Compressed Printing lets you put a 
lot of text in a narrow space, especially helpful if you are 
printing on 3-by-5 cards. 

0 Print only Factsheet TeHt 

® also print Names 

®also print Created: and Modified: 

® also print Keywords 

Paper Length c=J Inches and D 16ths 

Bottom Margin c=J Inches and D 16ths 
® Standard Print 0 Compressed Print 

Cancel 

Figure 8.45 The Page Setup dialog box 

Pull down the File menu and select Print. 
The Factfinder Print dialog box will appear. Print Fact­

sheet Names give you a list of all your factsheets by name. 
Print Keywords gives you a list of your keywords, which is 
useful if you are working with a large amount of Material. 

®Print Selected Factsheet 

0 Print Fectsheets found In lest search 

0 Print RLL Fact sheets in Stack 

0 Print Factsheet Names 

0 Print Keywords with occurrence counts 

OK Cancel 

Figure 8.47 The Factfinder Print dialog box 

Accept the preset values and check OK. The usual Mac 
Printing dialog box follows. Set it to fit your type of paper 
and check OK. 

If you have followed the steps of this example exactly, 
the dictionary factsheet will come off your printer like this: 

All created things viewed as constituting one system or whole; the creation; 
the cosmos. 



Access II 
Apple Computer 
20525 Mariani Avenue 
Cupertino, CA 95014 

Augterm 
Tymshare 
20705 Valley Green Drive 
Cupertino, CA 95014 

Factfinder 
Forethought 
1973 Landings Drive 
Mountain View, CA 94043 

Filevision 
Telos Software Products 
34 20 Ocean Park Boulevard 
Santa Monica, CA 90405 

MacDraw 
Apple Computer 
20525 Mariani Avenue 
Cupertino, CA 95014 

MacPaint 
Apple Computer 
20525 Mariani Avenue 
Cupertino, CA 95014 

Mac Write 
Apple Computer 
20525 Mariani Avenue 
Cupertino, CA 95014 

MegMerge 
5703 Oberline Drive 
San Diego, CA 92121 

Microsoft Chart 
Microsoft 
10700 Northrup Way 
Bellevue, W A 98004 

Microsoft Multiplan 
Microsoft 
10700 Northrup Way 
Bellevue, W A 98004 

221 



222 MACINTOSH 

Microsoft Word 
Microsoft 
10700 Northrup Way 
Bellevue, W A 98004 

PFS:file & PFS:report 
Software Publishing Co. 
1901 Landings Drive 
Mou'ntainview, CA 9404 3 

PC to Mac 
dilithium Press Software 
8285 S.W. Nimbus 
Beaverton, OR 97005 

The Source 
1616 Anderson Road 
McLean, VA 22102 

ThinkTank 128 
Living Videotext 
1000 Elwell Court 
Palo Alto, CA 94303 

Trade*Plus 
POB60970 
Palo Alto, CA 94025 



1040,87 
9600-baud, 136 
A4, 12 
About the ... , 10 
Accents, 47 
Access II, 127 
Access III, 127 
Add legend (Microsoft Chart), 114 
adjusting column width (Multi-

plan), 85 
Ahab Whalebone, 200 
Adjusted Gross, 99 
Adjustments to income, 97 
Alarm Clock, 11 
Align Center (Multiplan), SOx, 89 
Apple Cluster Controller, 126 
Apple II, 127 
Apple III, 127 
Apple menus, 10 
Apple Modem, 140 
Applications, 6 
Appline, 140 
Arrows (MacDraw), 74 
Arrange menu, 67 
Arrow Tool, 68 
Artificial intelligence, 27 
Atlanta, 197 
Atlantis, 201 
ATS card, 136 
Augment, 1,4,150ffx 
Augterm, 151ffx 

Backspace, 32, 

Index 

Baud, 137,140x 
Bold, 43 
Borders (Microsoft chart}, 122 
Boxes, 5,8x,12 
Bring to Front (MacDraw), 67 
Brochure, 178 
Built-in functions (Multiplan), 85 
Bulletin Board, 126,142,145x 

Cables, 135 
Calculator, 11 
Cards, 128, 136x 
Cassette Label, 56 
Catalogues of diskettes, 17x,8 
Centering in Word, 166 
Change, 167 
Changing diskettes, 18 
Changing fonts(Microsoft Word) 

166 ' 
Character menu (Microsoft Word) 

166 ' 
Circle (MacDraw), 72 
Clear, 14x 
Clear (MacDraw), 58 
Clear (Multiplan}, 95 
Clicking, 4 
ClickArt, 182 
clicking, 4 
Clip art, 182 
Clipboard, 13x,ll7,163,164 
Clipboard (Microsoft Chart), 185 
Close, 7x,39 
Closebox, 7 

Close Down, 36 
Closing files, 39 
Cluster Controller, 140 
Conditional highlighting screen 

(Filevision), 194 
Column Width(Multiplan), 89 
Combination, 122 
Commas(Multiplan), 89 
Communication, 125 
Compatibility (MacTerminal), 129 
Continuous paper, 36 
Control Panel, 11 
Copy Prevention (Microsoft), 162 
Copy protection (Factfinder), 213 
Copying, 13,40 
Copying files, 17x, 162,182 
Copying programs, 17 
Copying whole diskettes, 17 
Correcting errors (MacDraw), 58 
Correcting errors (Multiplan), 81, 

90,95x 
Correcting typing errors, 33,34x 
Create a report format 

(PFS:report}, 211 
Credits, Other Taxes, and Pay-

ments, 102 
Cursor, 3x,31 
Cursor shapes, 109x, 122, 197 
Custom Rulers (MacDraw), 57 
Cut, 13, 14x 
Cut (Multiplan), 95 
Cut sheet paper, 36 
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Data, 190 
Data Bases, 190 
Data Menu(Microsoft Chart), 111 
Date, 17 
Date Series(Microsoft Chart), 111 
Date(Microsoft Chart), 111 
Define Name (Multiplan), 93x, 101 
Deselecting, 34x, 59 
Designing a form (Filevision), 199, 

206 
Desktop, 5. 7x 15 
iacritical marks, 47 
Diagrams, 191 
Dialog, 191 
Dialog Box, Typing in, 33 
Dialog Boxes, 8x,23 
Dilithium, 132,135 
Dip Switches, 128 
Diskette copying, 17 
Division layout(Microsoft Word), 

179 
Dollar(Microsoft Chart), 112 
Dollar(Multiplan), 89 
DOS (IBM operating system), 134 
Double Click, 2, 7x 
Double sided disk drives, 26 
Draft (quality printing), 12 
Dragging, 4 
Dummy text, 170 
Duplicate, 19x,37 
Duplicating files, 37 

Edit menu, 9, 13x 
Eject, 13x, 19,36,182 
Electronic Mail, 125,150,153x, 
Elevator, 7 
Empty trash, 17 
Engelhart, Doug, 150 
Entering formul in Multiplan, 83 
Eraser (MacPaint), 186 
Errors, correcting typing, 33,34x 
Exemptions, 91 

Faces, 19 
Factfinder, 191, 212,213x 
Factsheet (Factfinder), 213 
Factsheet Menu (Factfinder), 215 
Fanfold, 36 
Field, 191x, 206 
File, 5,6x,11,13,191x 
File copying, 17x, 162,182 
File Menu, 11 
File Names, 32 
File Saving, 32 
File Transfer, 133, 137x 
File transfer (MacTerminal), 130 
Files, 132 
Filevision, 191x 

Filevision tools, 193 
Filing Status, 90 
Fill Down (Multiplan), 98 
Fill Menu (MacDraw), 57 ,62x 
Fill Pattern, 62 
Fill Right (Multiplan), 84 
Find forms (PFS:file), 210 
First Category(Microsoft Chart), 

112 
Flashing Rectangle, 72 
Folders, 5, 7x 
Font File, 23 
Font Mover, 21x, 23 
Fonts, 19, 20-23x, 38,133 ff 
Fonts (Microsoft Chart), 123 
Footers, 47 
Footnotes, 134, 172x 
Form 1040, 87 
Format, 33 
Format (MacWrite), 43,47 
Format (Multiplan), 80,84 
Format Menu (Microsoft Chart), 

122 
Format(Microsoft Chart), 112 
Format(Multiplan), 89 
Forms, 191, 205, 206 
Formul, entering in Multiplan, 84 
Functions (Multiplan), 85 
Functions menu (PFS:file), 208 

209x 
Funny Hat, 67 ,61x 
Functions (Multiplan), 85 

Gallery(Microsoft Chart), 114 
General format (Multiplan), 93 
Georgia, 197 
Get Info (Filevision), 13 
Ghost image, 18 
Ghost image in MacDraw, 73 
Glossary(Microsoft Word), 176 
Goodies (MacPaint), 183 
Graphics editor (Filevision), 197 
Grouping Objects (MacDraw), 72 
Gummed labels, 203 

Hair Lines (MacDraw), 58 
Hand, 72,74 
Hand (Multiplan), 94 
Hand tool (MacPaint), 183 
Handles, 58,203 
Handles (Microsoft chart), 122 
Happy face, 15 
Hard disks, 26 
Header Icons, 48 
Headers, 47 
Headings, 159 
Help systems, 153 
Hide Rulers, 31 

High (quality printing), 12 

I-beam, 33 
1-beam (Multiplan), 81 
IBM A TS Card, 136 
Icons, 6,15,16x 
If construction (Multiplan), 100 
Illustrating, 29,50 
Imagewriter, 12x,29 
Income, 94 
Indenting (MacWrite), 46 
Indenting (Microsoft Word), 171 
Index,(Factfinder), 219 
Initialization, 15 
Insert Ruler, 46 
Inserting text, 34 
Insertion Point, 1, 2x,31,33 
Integrated Software, 2,23x,24,29 
International Fanfold, 12 
Inventory, 205 
Inverse Video, 33 

Japanese Poetry, 217 
Jobs, Steve, 69,125 
Justification, 46 

Keycaps, ll 
Keys for .... window (Factfinder), 

215 
Keys Menu(Factfinder), 215 
Keywords, 191x, 213,215 
Kitchen, 65 
Kitchen Sink, 69 

Labels, 202 
Larger memories, 25, 26x 
Laser printers, 27 
Lasso (MacPaint), 51 
Layout menu (MacDraw), 57 
Letter, 33 
Letter quality printer, 21 
Library, 191 
Line Thickness, 57,59x 
Lines Menu (Mac Draw), 57 ,62x 
Lines, selecting them, 165 
Linking Files (Multiplan), 96x,l15 
Lisa, Preface, 1,15, 28 
Login, 151 

MacDraw window, 56 
MacPaint, 51, 55, 108,182 ff, 185 
MacPaint tools, 184 
MacWrite Window, 31 
Mail Lists, 202 
Mail merge program, 37 
Mailing labels, 202x, 204 
Map, 193 
Margins (Microsoft Word), 171 
Marquee (MacPaint), 184 
MegaMerge, 29,37, 43x 



Memory, 19,21x, 157 
Menus, 2 
Mathematical functions (Multi­

plan), 85 
Mistakes, correcting them in Mac-

Draw, 58 
Modem, 140x,135 
Modem Eliminator, 141x,135 
Modular Phones, 140 
Mouse, 2,3,4x,150 
Move bar, 7 
Multiplan (with Microsoft Chart), 

116 
Multiplan SYLK File, 133 
Multiplan Window, 80 
Music, 27 
MWOOOl, 178 

New files, 39,72 
New Series (Microsoft Chart), 108, 

nox 
New series Window (Microsoft 

Chart), 111 
New York, 39 
Noisy Phones, 141 
Notepad, 10 
Notes, 191 
Null Modem, 136,141 

Object (Filevision), 200 
Open Footer, 49 
Open Header, 48 
Opening files, 409 
Orbit, 191 
Outlines, 159, 158x 

Page Count(Microsoft Word), 172 
Page numbering (MacWrite), 48 
Page numbers (Microsoft Word) 

176 
Page Setup, 13x 
Page setup (Microsoft Word), 179 
Page setup (Multiplan), 86, 107 
Panes, 173 
Paper Quality, 56 
Paragraph formats (Microsofl 

Word), 171x,174 
Paragraphs, 46 
Paragraphs (Microsoft Word), 165 
Password, 142 
Paste, 13, 14x,40,7 
Paste and Link (Multiplan), 96 
Pattern dialogue box (Microsoft 

Chart), 122 
PC, 132 
PC to Mac, 132 
PC to Mac cable, 143 
PC to Mac mode, 136 
Pen Menu (MacDraw), 57 ,62x 

Pen Pattern (MacDraw), 62 
PFS:file, 205x, 190 
PFS:report, 205 
Plain text, 43 
Playing around with tax numbers, 

88 
Playing with charts, 120 
Plots Series (Microsoft Chart), 113 
Poetry, 217 
Point (type sizes), 21 
Pointing, 2 
Polygons, 61,66x 
Printing, 12x,35 
Printing (Factfinder), 219 
Printing (Microsoft Chart), 115 
Printing (Multiplan), 105 
Printing (PFS:report), 211 
Printing Factsheets, 219 
Printing, (Filevision), 202 
Printing, (PFS:file), 210 
Program, 6x 
Program icons, 15 
Proportional spacing, 134 
Puzzle, 11 

Quit, 12 
Quitting applications, 36 

Readers Digest, 142 
Receive File(PC to Mac), 139 
Record, 191 
Rectangle with rounded corners, 

69 
Refund or Amount You Owe, 104 
Relative locations(Multiplan), 83 
Remove Headers (Mac Write), 49 
Removing Fonts, 21 
Replace, 33 
Replace a Word, 33 
Report printing (PFS:report), 212 
Reverse Video, 33 
Right Margin, 46 
Rotating objects (MacDraw), 75 
Ruler Icons (MacWrite), 46 
Rulers (MacDraw), 57 
Rulers (MacWrite), 46x 
Rulers (Microsoft Word), 170 
Running Footers (Microsoft 

Word), 173 
Running Heads (Microsoft Word), 

173 ff. 

Sad face,15 
Save, 11x,32 
Save As ... , 1lx, 134, 186 
Saving and not changing, 117 
Saving Files with two disk drives, 

165 
Scale of Ruler (MacDraw), 57,65x 

Scrapbook, 10 
Scroll bar, 7 
Scrolling, 7 
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Scrolling (Multiplan), 94 
Search and Change, 167 
Searching (Factfinder), 218 
Searching (Filevision), 194 
Searching (PFS:file), 209 ff 
Selected, 33 
Selecting a paragraph (Microsoft 

Word),l70 
Selecting a sentence (Microsoft 

Word), 170 · 
Selecting hidden objects (Mac­

Draw), 67 
Selecting Rows and Columns in 

Multiplan, 84 
Selecting Text, 34 
Selecting text (Microsoft Chart), 

122 
Send a file (MacTerminal), 131 
Send File (PC to Mac), 137 
Setting up a form (Filevision), 199, 

206 
Shadows of icons, 18 
Show Clipboard, 13 
Show page (MacPaint), 183 
Single sheets of paper, 36 
Software integration, 

23-24,50,178 
Source, The, 125, 142x 
Spaces (Microsoft Word), 166 
Special, 16, 17x 
Spreadsheets, 77, 190 
SRI, 2,150 
Stack (Factfinder), 213 
Standard (quality Printing), 12 
Standard menus, 9 
Star Trek, 132 
Starting an application, 30 
Starting the Mac, 15 
Statistics, 108 
Stock Market, 146,148x 
Style menu, 43,44 
Sub-items, 159 
Subscription services, 126 
Super Serial Card, 127,141 
Superscript, 175 
Switching active windows, 72 
SYLK, 85, 133 
Symbols (Filevision), 197 
Systems Folder, 16x 24 

Tab wells, 43 
Tabbing, 43,44 
Talking Macs, 27 
Tax Computation, 100 
Telenet, 142 
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Terminal mode, 134 
Texas, 194 
Text, 31 
Text Format Dialogue Box (Micro-

soft Chart), 122 
Text On ly File. 133, 134,139 
ThinkTank 128, 158 
Thorn & Co. , 79, 109, 116, 133. 178. 

197 .206 
Three-by-five Cards. 19 1, 212x 
Three-column format , 179x, 181 
Tinker Menu(Fi levision), 194 
Title page (MacWrite, 47 
T rade" Plus. 146x 
T rade"Pl us order procedures, 149 
Trash , 17x 
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T rue Circle, 72 
Turnkey application, 6 
T ymnet , 151 
T ymshare, 150 
T ype definition (File,·ision), 198 
Type faces. I9xff,29 
T ype fonts. 19x ff 
T ypefaces, changing in text , 38 
T ypes Menu (Filevision), 193 
T yping. 32 
T yping errors, correcting, 33,34x 

Underline, 43, 167 
Undo, 13 
Undo Typing, 31 
Uni ted States , 193 
Universe, 159,212,214 

Unlink , 96 
Upward compatibility, 26 
US Letter, 12 

Yen-tel, 140 
Venice, 38 
View, 17x 

W indows, 7x, l6 ,15 
Word, 33 
Word processors, 190 
Work files (Microsoft Word), 178 
Wozniac, Steve, 125 
Wrist watch, 4 

Xerox, I 

Zero po int (MacDraw), 57 
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Before you can click into high gear with 
your Mac, you need to know how to get 
where you're going. Macintosh: A Concise 
Guide to Applications Software gives you 
the basics of using Mac's word process­
ing, spreadsheet, drafting and design, 
and database management functions. It 
explains what the machine is capable of 
doing, then shows how to run the most 
popular applications programs. Clear, 
step-by-step instructions and as many as 
sixty illustrations per chapter make it 
smooth going. 

From MacWrites and MacDraws to Multi­
plan~ Microsoft Chart~ Microsoft Words 
and MacTerminal~ among many others, 
this software guide candidly reviews the 
most exciting and useful Mac software on 
the market. It tells you the ones to buy, 

gives detailed instructions on how to use 
them in realistic applications, and even 
gives a glimpse of what's to come with 
previews of beta-test versions of new 
Mac software soon to hit the market. 

In addition, Macintosh shows how to 
create charts and illustrated brochures, 
move text files from other machines to 
the Mac, and reach several online ser­
vices through public networks. 
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